
        SAP Enterprise Portal 

Prepared By 

Vamshi Krishna Katta 

1 

 

 

 

 

 

 

 

 

 

SAP Enterprise Portal Concepts 

Version --7.0 to 7.4 

 

 
By 

Vamshi Krishna Katta 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



        SAP Enterprise Portal 

Prepared By 

Vamshi Krishna Katta 

2 

 

Contents: 

 
1. SAP EP 

2. SAP Net weaver 

3. Difference between 7.0, 7.01, 7.3, 7.4, 7.5 

4. PCD Objects 

5. Types of iviews 

6. Branding 

7. System Object 

8. SSO 

9. Masthead Customization 

10. Logon Page customization 

11. UWL Configuration 

12. UME Configuration 

13. LDAP 

14. Collaboration 

15. Forums 

16. WIKI’s 

17. KM 

18. UME Roles, Portal Roles 

19. UME Actions 

20. ESS/MSS BP’s 

21. ESS SPRO 

22. ESS LPD CUST 

23. FPM 

24. GUIBB 

25. POWL 

26. JCO Destinations 

27. SLD Configuration 

28. RFC Destinations 

29. BCM 

30. Creating mass users 

31. Permissions 

32. Infotypes 

33. Framework page customization 

34. Integration with SRM 

35. Integration with CRM 

36. Integration with BW 

37. Integration with BI 

38. Integration with UI5 

39. Integration with Fiori 

40. Fiori Launchpad on Portal 

41. NWBC 

42. Transport 

43. Translation  

44. Remove irj/portal 

45. External Facing Portal 

 



        SAP Enterprise Portal 

Prepared By 

Vamshi Krishna Katta 

3 

 

Web Dynpro Java:  
46. Component 

47. DC’s 

48. Controllers 

49. Supply functions 

50. Dispose functions 

51. Cardinality 

52. Simple Types 

53. Models 

54. Context binding, Model binding 

55. RFC 

56. BAPI 

57. Messaging 

58. Creating a DC with Model 

59. Web Dynpro JAVA vs Web dynpro ABAP 

60. NWDI  

 

61. Upgrade Issues 

62. Project Implementation steps. 

63. FAQ’s 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



        SAP Enterprise Portal 

Prepared By 

Vamshi Krishna Katta 

4 

1. SAP EP 

 
SAP stands for Systems Applications and Products in data processing. SAP R/3 system 
is a business package designed to integrate all areas and modules of business. 
SAP provides end to end solutions for financial, manufacturing and logistics etc… 
 
SAP R/1 is first version and called as one tier architecture. 
Presentation+Application+Database 
SAP R/2 is second version and called as two tier architecture. 
Server One --->Presentation   Server Two---> Application+Database 
SAP R/3 is third version and called as three tier architecture. 
SO-->Presentation ST--> Application ST-->Database 
 
Key Capabilities: 
Unification 
Single Sign On 
Collaboration 
Knowledge Management 

 

2. SAP Net weaver 

 
SAP Net weaver Architecture : SAP Net Weaver Architecture mainly includes 4 
components : 
People Integration :   Multichannel Access 
Portal 
Collaboration 
Information Integration :  Bus Intelligence 
KM 
Master Data Management 
Note: In the latest version KM is integrated into People Integration. 
Process Integration :   Integration Broker 
Business Process Management 
Application Platform :  J2EE, ABAP 
DB and OS Abstraction 
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3. Difference between 7.0, 7.01, 7.3, 7.4, 7.5 

 

                    SAP NetWeaver portal version differences 

7.01 7.3 7.4 7.5 

In 7.0 we are 

using Visual 

admin ,Sdm, 

Jspm tools for 

deployment 

and 

undeployment 

NW 7.3  EHP 1 SP09  on 

wards CONFIG TOOL , 

TELNET tool, NWDS, 

SUM, NWA tools we can be 

used for deployment and 

undeployment and For 

administration purpose 

NWA tool we can use. 

We can constantly monitor all 

operating processes using SAP 

Solution Manager 7.1. 

SAP Enterprise Portal 

UX renovation 

according to SAP Fiori 

UX paradigm: 

In 7.0 we don't 

have PAR 

migration tool 

Portal 7.3 and higher have 

PAR migration tool.  

Java iDOC adapters and B2B 

add-ons for EDI are available. 

 S/4 HANA integration 

by supporting S/4 

HANA content 

(analytical apps, 

factsheets)  

Only PAR files 

are supported 

Only WAR files are 

supported. We need to 

migrate any PAR files to 

WAR files packaged in EAR 

files. 

There have been rapid advances in 

process orchestration, including 

that the Advanced Adapter Engine 

and SAP NetWeaver Business 

Process Management now run in a 

single stack, which potentially 

means less hardware and reduced 

energy costs. 

 Cloud Services 

integrated into SAP 

Enterprise Portal by 

SAP Web IDE 

deployment plugin, 

enabling developers to 

create and deploy 

Fiori-like apps to the 

Portal. 

 

Advanced wizard for role 

upload, content creation & 

transports 

SAP NetWeaver 7.4 is optimized 

for SAP HANA 

New Fiori SCA, 

allowing an easy and 

lean upgrade of Portal 

in the context of Fiori 

scenarios. 

 

Dedicated editor for role 

following  the UX 

guidelines for work center 

roles of SAP Business suit 

For mobile, SAP Net Weaver 7.4 

offers technologies such as 

SAPUI5, SAP HANA Cloud, and 

SAP Net Weaver Gateway.  

Embedding SAP UI5 

applications into SAP 

Fiori launchpad, Enable 

tile personalization 

 
Hot folders – automatic 

transports 

Integration of SAPUI5 

applications 

SAP Web IDE Plug-In 

which enables to deploy 

an Web IDE application 

to the Portal 
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Out-of-the-box support for 

3rd party portal integration 

UI Theme Designer Easy theming 

of the portal experience 

Administrators can 

configure a News iView 

to run as a news tile that 

displays article feeds to 

end users in the SAP 

Fiori launchpad. 

 Enhanced FPN framework 

Supports integration of 

SAPUI5-based applications via 

new iView template from the 

portal’s GPAL repository 

End users can set the 

theme in the SAP Fiori 

launchpad. 

 

Modular installation 

approach allowing to install 

only those services which 

are needed 

Fully integrated with portal and 

work spaces via pre-configured 

iViews, SSO, universal worklist 

and search 

Administrators can now 

configure iViews and 

pages to appear as links 

or tiles in the home 

page. 

 
Enhanced browser support 

IE8, Firefox & safari 

Foundation for SAP Business 

Suite on SAP HANA 

End users can now drag 

dynamic navigation 

popups to a new 

location. 

 Support for JDK 6 
It is support for fiori application 

and integration 

Quick links are now 

supported in the Fiori 

Framework Page. 

 

Avg. response time for a 

reference scenario 

significantly reduced 

compared to 7.01 SP5 

We have fiori launchpad 

configuration so that we can 

display the applications as Tile 

format. 

mobile, cloud, big data 

and analytics and offers 

a foundation for the 

easy and fast 

development of simple 

business applications 

 BOBJ Portal integration kit   

 New web page composer   

 
We have wikis in 

collaboration 
  

 

 

4. PCD Objects 

 
Iviews: Program that retrives the data from content sources in company and on the 
internet and displays in content area of EP 
Pages: Consist layouts and assigned iviews 
Worksets: Specific collection of tasks, Services and information that is part of a role. 
Roles: A collection of task services and information that is available for users or 
groups. 
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5. Types of iview templates 

 
Iview from Template: 
KM iviews 
SAP BSP iview 
Fiori iview 
SAP RFC iview 
URL iview 
Workset map iview 
 
Iview from Remote source:  
SAP Portal component iview 
Transaction 
Web Dynpro ABAP 
Web Dynpro JAVA 

 

6. Branding 

 
Portal Theme 
Framework Page: Portal Users -> Standard Portal Users 
Desktop 
Master Rule Collection: Portal Administration -> Super Administration 
 
How to change HTML header title: 
NWA->Configuration->Infrastructure->Java System Properties->Services Tab -> Portal 
Runtime Container Extension -> Portal.html.head.title 
 
How to change the loading image. 
Export the Theme -> ur.zip -> common ->loading -> change the image loading_ani.gif 

 

7. System Object 
 
System Object is a set of connection properties to represent an external or SAP 
systems, used to retrieve data into portal iviews. 
 
System Alias settings 
 They are a means of retrieving the information stored on database servers without 
having to know the name of the server. 
Connector settings 
ITS settings: Maintained for displaying SAP transactions in the portal as an iviews.  
WAS settings: TO display BW reports and BSP applications. 
User Management Settings: UID/PWD or Logon ticket 
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8. SSO 

 
1.Set the following profile parameters in RZ10. 
Login/create_sso2_ticket  = 2; 
Login/accept_sso2_ticket =1;  
 

2. NWA -> Configuration-->Security-->Certificates and Keys  

select the ticket keystore in the key storage. 
select the SAPLogonticketpair-cert in the “View Entries” and click on Export  
Select export format-Base 64 type and click on Download 
3. STRUSTSSO2 -> import certificate 
Add to Certificate List and add to ACL 
4. NWA -> Configuration-->Security-->Trusted Systems-->Add Trusted Systems 
select the By Querying System 
If the backend system is already maintained in the tech systems of SLD it will come in 
the list other wise you have to enter the following details and click on Next 
After the next the ECC system certification will be added. 
 
5. Now make RFC connection between ECC and EP. 

 

https://sapbasisbyankur.blogspot.in/2016/08/sso-configuration-between-sap-portal-
73_8.html 
 
NWA -> Configuration -> Connectivity -> JCO RFC provider 
Create Program 
SM59 -> TCP/IP Connection and Click on Create button 
Provide Program name and Gateway host details.  

 

9. Masthead Customization 

 
1. Download from your SAP NW 7.31 Server this WAR 
File: com.sap.portal.navigation.afp.masthead.war 
Path: C:\usr\sap\<SID>\<Instance>\j2ee\cluster\apps\sap.com\com.sap.portal.navig
ation.afp.masthead\servlet_jsp\ com.sap.portal.navigation.afp.masthead 
 
2. Download from your SAP NW Server these  JAR Files: 
common.jar 
com.sap.portal.useragent_api.jar 
com.sap.portal.search.service_api.jar 
com.sap.portal.search.provider_api_api.jar 
com.sap.portal.runtime.system.favorites_api.jar 
com.sap.portal.productivity.resolverservice_api.jar 
com.sap.portal.pcd.glservice_api.jar 
com.sap.portal.navigation.service_api.jar 

https://sapbasisbyankur.blogspot.in/2016/08/sso-configuration-between-sap-portal-73_8.html
https://sapbasisbyankur.blogspot.in/2016/08/sso-configuration-between-sap-portal-73_8.html
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com.sap.portal.navigation.helperservice_api.jar 
com.sap.portal.navigation.api_service_api.jar 
com.sap.portal.core.utils_api.jar 
com.sap.portal.contenttaggingservice_api.jar 
com.sap.portal.common.commonservices_api.jar 
Notice: Most of them you will find in following path: 
C:\usr\sap\<SID>\<Instance>\j2ee\cluster\apps\sap.com 
 
3.Open your NetWeaver Developer Studio (NWDS) 
Import the WAR File com.sap.portal.navigation.afp.masthead.war 
In NWDS: File -> Import and choose your WAR File 
 
4.To fix errors you have to config your build path and import the JAR Files 
Right click on your import WAR file and choose Build Path -> Configure Build Path in 
context menu. 
 
5.Select all JAR Files on your file system and paste the files into the lib folder. 
Right click on your import WAR file and choose Build Path -> Configure Build Path in 
context menu. click button Add Jars…and add all JAR Files from lib. 
 
6.Make your changes on your Masthead.jsp file. Save your file.  
 
7.Right click on your web module and choose Export. Export as WAR File. 
Switch to Deployment Perspective and import your new WAR File for deployment. 
Click on button Import, choose File System and select your WAR File. 
 
8.Content administration -> select portal application search for the war file 
Select Header iView 
Assign the iview to Framework page. 
 

 

10. Logon Page customization 

 
Portal 7.0:  
 
1. Download the com.sap.portal.runtime.logon par.bak file 
from portal 
    a) Goto>System Admin>Support>Portal Runtime>Browse Deployement 
  
2. Save it on your local machine 
3. Rename it to com.sap.portal.runtime.logon.zip 
4. Extract the files while keeping the directory structure 
5. Modify the appropriate files 
6. Put modified files back into the PAR file 
7. Deploy/Upload the new PAR file 
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Portal 7.3 and 7.4 : 
 
1. First step is to get the WAR file tc~sec~ume~logon~ui.war from 
<Installation 
drive>:\usr\sap\<SID>\J00\j2ee\cluster\apps\sap.com\com.sap.security.core.logon 
\servlet_jsp\logon_ui_resources\tc~sec~ume~logon~ui.war 
 
2. NWDS -> File –> Import –>Web –> War File 
check the “Add project to an EAR “check box and specify suitable name in “EAR 
project name “based on the 
   WAR project name. 
   Click Finish to create both WAR and EAR projects. 
Expand the WAR project. 
 
3. Adding the required JAR file to remove the Errors. 
     a. Copy the “tc~sec~ume~logon~logic_api.jar” file to 
the WebContent\WEB-INF\lib folder of the WAR project in NWDS. 
  b. Right Click the WAR project and select Build Path –> Configure Build Path. 
   c. Click on Libraries tab.Click on “Add External  Jars”  and select the JAR file 
“tc~sec~ume~logon~logic_api.jar” from local system and “Add”  
 
4. Make Changes to Layout 
    a. Now its time to start making the desired changes to the layout. 
  b. Right Click on WAR project and select Java EE Tools –>Update EAR Libraries. 
 
5. Configuring deployment descriptors 

 a.  Configuring application-j2ee-engine.xml 
We have to provide this alias name later in NWA. 
 
6. Creating the deployable EAR file 
     Next we need to create a deployable EAR file . For this right Click on EAR project 
and select Export –>SAP EAR file 
 
7. Deploying the EAR file 
     Right click on the EAR project and select Run As –> Run on server 
     Enter the credentials of the server and file will get deployed on the server with a 
success message. 
 
8. Configuring UME properties in NWAs 
     http://<host>:<port>/nwa/auth 
     a. Change the property Alias of the application for customizing login pages 
(ume.logon.application.ui_resources_alias)                 
          to custom  application “ new_logon” which we mentioned previously  in the 
Context root of application.xml 

http://scn.sap.com/%3chost%3e:%3cport%3e/nwa/auth
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     b.  Change the property Path or URL to the branding image 
(ume.logon.branding_image) to “layout/hearts.jpg” 
 

11. UWL Configuration 
 
UWL is centralized access point for work flow items. 
 
1. Assign the standard UWL iview to role. 
2. Create 2 system Objects 

Second system object WAS properties to be pointed to portal 
Create System alias as “SAP_Webdynrpo_XSS” 

3. System Administration -> System Configuration -> Universal worklist - 
Administration  
Click on NEW button 
4. Give system alias name  

Connector type: WebFlowConnector 
Webdynpro Launch System: as “SAP_Webdynpr_XSS” 

5. Save and Re-Register the connector 
6. Clear the cache in Cache Administration page. 
 
How to hide Tabs in UWL 
System Administration -> System Configuration -> UWL work list and work flow -> 
Click to configure item Types and customize views using a wizard -> Customize the 
look of the UWL main page. 
 
Troubleshoot UWL 
System Administration -> System Configuration -> UWL work list and work flow ->  
Click to manage Item types and views definitions -> To trouble shoot the configure 
content click here 
Select User, role or group  
Show Configuration 
 
To see UWL Support Information  
System Administration -> System Configuration -> UWL work list and work flow ->  
Optional Universal worklist service configuration 
Set parameter “Display support information=true” 

 

12. UME Configuration 
 
1.Use transaction SU01 to create a user of type System and assign it one of the  
 following roles: 
For read-only access from the AS Java to the ABAP system, choose the 
role SAP_BC_JSF_COMMUNICATION_RO 
For read-write access from the AS Java to the ABAP system, choose the 
role SAP_BC_JSF_COMMUNCIATION 
Ensure that the role is assigned and generated 
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Use transaction PFCG to generate the authorization profile and assign the user. See 
under the tabs Authorization and Users → User Comparison 
2.On the AS Java, start user management configuration 
3.Choose the Data Sources tab 
4.Choose Modify Configuration 
5.From Data Source, select ABAP System 
6.Choose the ABAP Server tab and Enter connection data as required 
7.Set the indicator Connection to a specific application server 
8.Enter the application server data 
9.Choose Test Connection 
If the test fails, go back and reenter the connection data and test the connection 
until you are successful 
10.Choose Save All Changes 
11.Restart the AS Java. 

 

13. LDAP 

 
Lightweight Directory Access Protocol, is an Internet protocol that email and other 
programs use to look up information from a server 

 
1. Start the UME Configuration 
2. Choose the Modify Configuration button 
On the Data Sources tab page, select the data source that best matches your LDAP 
directory 
3. Choose the LDAP Server tab page, enter connection data as required 
4. The settings for configuring the LDAP directory connection 
5. Choose the Validate Configuration button 
6. If the test fails, user management configuration displays the entry from the 
security log. The monitoring tools of your LDAP directory can also help you 
determine the cause of the problem. If necessary, go back and reenter the 
connection data and test the connection until you are successful 
7. Enter the rest of the data as required 
8. Save your entries. 
9. Restart the AS Java. 

 

14. Collaboration 

 
Collaboration acts as forums, instant messenger, rooms etc.. Which helps the users 
of project group in different geographical locations to collaborate each other 
effectively both in real time and synchronously. 
Collaboration content mainly includes collaboration objects such as People, Rooms, 
Discussions etc...  
 
Room Creation in Collaboration :  
 In the Top Level Navigation area go to Content Administration->Collaboration 

Content.  
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 On the left side Detailed Navigational area you will find Room Creation link.  
 Click it.That will open a New view on right side panel where you provide the 

details to create a Collaboration Room. 

 

15. Forums 

 
Forums allow portal users to share information and opinions about specific subjects 
or questions.  
 
Portal 7.0 Steps: 
 
1.Download and deploy the FORUMS and KMCUI SCA files. 
 
2.Creating Forum Iviews: 
 
After deploying the forums application to your portal, you need to make the forums 
Home page and administration functions accessible from portal iViews.  
In the portal, choose Content Administration -> Portal Content. 
In the Portal Content Studio, open the folder Portal Content Provided by SAP ->iView 
Templates. 
In the context menu of the Collaboration Forums iView, choose Copy. 
Locate the target folder (a folder of your choice) and choose Paste as Delta Link in its 
context menu. 
Rename the custom iView template so that you can distinguish the specific iView 
template from the default one in the iView creation wizard. 
Create the Minimal Set of Forums iViews 
Create the required Forums iViews on the basis of the custom iView template for 
forums.  
To work with forums in the portal you need at least the following views of the 
Forums application: 
 User view (Forums Home page) 
 Administrator view (Admin Console) 
 
The procedure for creating these three iViews is the same, but their configuration 
differs. To create each of the Forums iViews, proceed as follows: 
Procedure Forum iView for providing a 
user view (Forums Home page) 

Select the Forums Configuration property 
category. 
For the View on Forums property, select 
Forums. 
Select the Navigation property category. 
For the Quick link property, enter forums. 
configuration. 
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Forum iView for providing an 
administrator view (Admin Console) 

Select the Forums Configuration property 
category. 
For the View on Forums property, select 
Forums Administration. 
Select the Navigation property category. 
For the Quick link property, enter forums 
admin. 
If the forums admin quick link is configured 
for another iView in your portal, change 
the configuration. Otherwise, your portal 
users may be redirected to the wrong 
iView. 

Forums iView for assigning an initial 
forums system administrator 

Select the Forums Configuration property 
category. 
For the View on the forums property, 
select Add Forums Administrator User. 

 
3. Create Portal Roles and Assign Forums iViews to Them 
 
To make the Forums iViews accessible from the portal, you need to create specific 
portal roles. These portal roles must be created as portal content, not as UME roles. 
You can either assign single iViews to portal roles or integrate iViews into pages, 
worksets, or layouts and assign these objects to the required portal roles. 
Assigned iViews Forums 
Administration 

Forums Administration 
Add Forums Administrator 
User 

Forums User Forums Home 
Forums Moderation 

 
Portal 7.4 Steps: 
 
1.Download and deploy the FORUMS and KMCUI SCA files. 
 
2.Forum Iviews: 
 
-         User view (Forums Home page) 
-         Administrator view (Admin Console) 
-         Special administrative iview(u need this iview to access admin console)  
 
Creation of  User iview:  
Content Administration--Portal Content Management-Portal Content--User 
Required folder--rightclick---New-Iview--iview from template-Select 
Collaboration Forum Iview-iview ID----Next--Ok 
Select collaboration forum iview 
Edit the properties of User iview: 
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Content Administration--Portal Content Management--Portal Content--User 
folder--iview folder-Right click on user iview--Open-Properties. 
Now go to select the property category in that dropdown select Forums 
Configuration then edit the property View on SAP forum to Forums 
And then select navigation in select property category edit the property Quick link to 
forums and save the changes by click on Save button. 
Follow the above steps for creating the administrator iView and Special 
administrator iView. 
 

Admin iView 
 
 
  
 

1. Select the property category Forums 
Configuration.  
2. For the property View on Forums, select Forums 
Administration.  
3. Select the property category Navigation.  
4. For the property Quick link, enter forums admin.  

Special Admin iView 
 

1. Select the property category Forums 
Configuration.  
2. For the property View on the forums, select Add 
Forums Administrator User. 

 
Creation of forum admin role and forum end user role: 
Now we need to create two roles(Forum admin role and Forum end user role) and 
assign iviews to the roles. 
 

Roles iViews 

Forum admin role 1.Administration iView 
2.Special administration iView 

Forum End user role 1.User iview 

 
3. Forum Role creation: 
Content Administration--Portal Content Management--Portal Content--User 
folder--->Roles--->Right click on folder--->new--->Role--->Free Style-->Role ID-->Ok. 
In the same way we should create Forum end user role also then we need to assign 
the iviews which we create before to the roles. 
 

Roles iViews 
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Forum admin role 1.Administration iView 
2.Special administration iView 

Forum End user role 1.User iview 
 

 
After assigning the iviews to roles we should assign those  roles to portal users. 
After selecting the required roles click on Add button and then Save the 
modifications of user details. 
After assigning the roles to the user he can able to see the Forums home page for 
admin and End user. 
 

16. WIKI’s 

 
The wiki application allows portal users to create author information collaboratively 
using Web pages. A single page in a wiki is referred to as a wiki page, whereas the 
entire body of pages, which are usually interconnected by means of hyperlinks, is 
"the wiki". A wiki is essentially a database for creating, browsing, and searching for 
information. 
 
 Collaborative information - such as proposed product plans which have multiple 

authors 
 Information with a longer life - such as a schedule of training classes 
 Information to be reviewed - such as documentation 
 Wiki technology supports many document types as attachments 

 

17. KM 

 
 SAP NetWeaver provides a central, role-specific point of entry to unstructured 

information from various data sources with the knowledge management.This 
unstructured information can exist in different formats such as text documents, 
presentations, or HTML files.  

 Workers in an organization can access information from different source such as 
file servers, their intranet, or the World Wide Web. A generic framework 
integrates these data sources and provides access to the information contained 
in them through the portal. 

 The Knowledge Management functional unit supports you in structuring 
information and making it available to the correct target audience. You can use 
the different functions on all content of integrated data sources, as long as the 
technical conditions are met. 

 Document creation and publishing 
 Taxonomies and classification 
 Search  
 Navigating in Folders 
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18. UME Roles, Portal Roles 
 
In the portal, you can manage both user management engine (UME) roles and portal 
roles. Both types of roles determine what users can do, but each with a different 
focus. The following table lists the main differences between these types of roles. 
 
 
 

UME Roles Portal Roles 

Are a container for UME actions (actions are 
sets of Java permissions). 

Are a container for portal content 
(iViews, Worksets, folders, and so 
on). 

Define a set of authorizations. By assigning a 
UME role, you define what authorizations a 
user has to run applications on SAP 
NetWeaver Applications Server (AS) Java. The 
authorizations are defined by the UME actions 
in the role. 

Defines how content is grouped 
together and how it is displayed in 
the portal. By assigning a portal role 
to a user or group, you define which 
content a user sees in the portal. 
Like UME roles, you can assign UME 
actions to portal roles. 

Are stored in the user management tables of 
the database of the AS Java. 

Are stored in the Portal Content 
Directory tables of the database of 
the AS Java. 

Are created with identity management. Are created with the Role Editor of 
the Portal Content Studio. 

Protect access to applications on the AS Java. Constitute a small part of the 
authorization concept of the portal. 
When you assign a portal role to a 
user or group, they get end user 
permission on the role. 
You can define role 
assigner permission on a portal role. 
Users or groups that are granted 
role assigner permission on a portal 
role can assign the portal role to 
users or groups. 

 

 

19. UME Actions 

 
 The user management engine (UME) uses UME actions to enforce authorizations. 

An action is a collection of Java permissions that define which activities a user 
can perform. UME actions can be assigned to UME roles or portal roles.  

 If a role with a UME action is assigned to a user, the user gains the 
authorizations provided by the action. The UME verifies that users have the 
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appropriate UME actions assigned to them before granting them access to UME 
iViews and functions. Other applications can also define or check for actions. 

 The following table lists the UME actions assigned to portal roles by default. 
 

 

 

 

 

 

20. ESS/MSS BP’s 
 
Employee Self Service is an web enabled tool used to update their own data by the 
employee itself.  
 
Manager Self Service is an web enabled tool used for managers to take report or 
update the data of subordinates.  

 
ESS/MSS(Web Dynpro ABAP) : 
BPERPESSWDA 1.50,                                                                   
BPERP05COMMON1.61, 
MSS Addon 1.0 
 
ESS/MSS(Web Dynpro Java) : 
WD Java ESS 633,  MSS 630,  PCUI_GP 633 versions 
BP for ESS - 1.41 
BP for MSS - 1.41 

 

21. ESS SPRO 
 
 SPRO -> SAP Reference IMG -> Cross Application Component -> Home page 

framework 
 Create Resource -> Provide Path of iview 
 Create Service -> Provide Resource Name, Description and link name 
 Create Sub Area 
 Assign the Service to Sub area -> Provide the Position 
 Assign the Service to area 

 

22. ESS LPD CUST 

 
 LPD_CUST -> New Launch Pad -> ZESS -> Copy from Other Launch pad ->  Copy 

the roles from ESS role (Instance MENU) 

Portal Role Assigned UME Actions 

Delegated User Administrator Manage_Users 
Manage_Role_Assignments 

Every User Core Role Manage_My_Profile 

Standard User Role Manage_My_Profile 

Super Administrator AclSuperUser 
Manage_All 

System Admin System_Admin 

User Administrator Manage_All 
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 Create Custom folders 
 Create Custom Applications 

 

23. FPM 

 
 Floorplan Manager (FPM) is a highly configurable user interface (UI) framework 

for easy and efficient application development and adaptation based on Web 
Dynpro ABAP. 

 With the help of predefined elements such as floorplans, toolbars and generic 
user interface building blocks, FPM provides you with consistency across 
applications and compliance with SAP UI design guidelines, as well as greatly 
reducing the time required to create such applications. 

 
Below are the steps to create a FPM application. 
 Create a Web Dynpro Component with the required UIBBs and implement the 

Web Dynpro interface IF_FPM_UI_BUILDING_BLOCK. 
 Create a Web Dynpro Application and specify parameters according to which 

floorplan instance you are using. 
 Using the FPM Configuration Editor, create a configuration for the application. 
 Test your application. 
 
http://www.saptechnical.com/Tutorials/WebDynproABAP/FloorPlanManager/Page2
.htm 
 

24. GUIBB 

 
 GUIBBs make it possible to improve the uniformity of these user-specific views; 

they provide an application with a harmonized look and feel. 
 GUIBBs are fully integrated into the FPM framework. Amongst other things, they 

take care of the UI layout, spacing, and certain product standards such as 
accessibility. GUIBBs provide you with a 'code-free' configuration of the UI. 

 GUIBBs are generic configurations based on feeder classes. There is a complete 
separation of the UI and the business logic; the business logic is contained in the 
feeder class. The application, at design time, defines the data to be displayed 
along with a configuration. The concrete display of the data on the UI is only 
determined by the GUIBB at runtime; this is done automatically using the 
configuration provided and with the data, to be displayed, specified by the 
feeder class. 

 GUIBBs can also be created dynamically at runtime; the FPM framework 
indicates the presence of such GUIBBs at design-time in the Message Area of the 
FPM configuration editor, FLUID. 

 

 

 

 

http://www.saptechnical.com/Tutorials/WebDynproABAP/FloorPlanManager/Page2.htm
http://www.saptechnical.com/Tutorials/WebDynproABAP/FloorPlanManager/Page2.htm
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25. POWL 
 
The Personal Object Worklist (POWL) is a Web Dynpro application that has to run in 
an Enterprise Portal environment. To use the worklist in an enterprise-specific portal 
role a POWL work center is required. 
 Create a new iView using the iView Wizard . 
 Choose the Source Type iView template – create an iview from an existing iView 

template . This template includes specifying all relevant portal data. 
 Enter SAP Web Dynpro iView for Select Type and type ABAP . 
 Enter the following parameters of the application: 

Portal system alias 
Select the system in which you have registered your feeder class.  
Application Name 
Enter POWL . 
Namespace 
Enter SAP 
Application Parameters 
Enter the Application ID you defined in the Customizing activity Define 

 Personalization Hierarchy 
 It is WebDynpro ABAP based 
 Connect different backend system to inbox and retrieve workitems from that 

system 
 Standard actions(Forward, resubmit) available for tasks 
 Additional actions can be configured for tasks 
 Additional POWL queries can be added  

 

26. JCO Destinations 

 
If you are using an adaptive RFC model in a Web Dynpro application, two 
JavaConnector (JCo) destinations are required. The application receives the 
metadata over the first connection, and application data is supplied to the Web 
Dynpro application over the second connection. 
 
 The data for JCo destinations is stored in the System Landscape Directory (SLD). 
 startPage -> Web dynpro -> Content Administration -> Maintain Jco Destinations 
 Choose Create JCo Destination. Either copy the data required for the JCo 

destination from an existing destination, or define a new connection with new 
data. 

 To define general data, create a logical name for the JCo destination. 
Alternatively, you can specify a client. 

 Specify the configuration of the JCo pool for a JCo destination. 
 Define cluster 
 Assign the JCo destination to a Java Engine cluster. A cluster means a distributed 

system of the Java Engine Dispatcher and further server elements. This system 
identifies the client as one unit. By default the locally installed Java Engine is 
selected. 

https://help.sap.com/saphelp_erp60_sp/helpdata/en/e2/acba53422bb54ce10000000a174cb4/content.htm
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 Define the data type and connection type 
 Select the data type for the JCo destination. The destination type for data type 

Dictionary metadata can only be a load-balanced connection. You therefore 
cannot select a single server connection. 

 There are two destination types available for data type Application data. 
 You then define the destination type. It can be one of the following: 
 Load-balanced connection 
 Single server connection 

 

27. SLD Configuration 

 
 The System Landscape Directory (SLD) of SAP NetWeaver is the central source 

of system landscape information relevant for the management of your 
software life-cycle. 

 Since the system information is updated automatically, the SLD provides reliable 
and up-to-date information with minimized effort for you. In this way, the SLD 
acts as a central information provider for SAP and third-party tools that use this 
data to deliver the services you need to keep your landscape up and running. 

 
Configure SLD User authorization: 
 
 Configuration of SLD security - Assigning SLD security roles and actions to users 

and user groups: 
 Open the SLD home page http://<host>:<port>/sld in a Web browser. 
 Navigate to  Administration  Settings   and choose tab page Server 

Configuration to apply the standard SLD role mapping. 
 
Configuring the server parameters - Starting the SLD server: 
 
 Open the SLD home page http://<host>:<port>/sld in a web browser. 
 Choose  Administration  Settings    Server Settings . 
 Enter a name for the Object Server . Preferably use a prefix that has been 

reserved on SAP Service Marketplace as an Object Server name. 
 Start the SLD server. 
 
Performing initial data import: 
 
 On the SLD home page, choose  Administration  Import . 
 Press Import CR Content . 
 
Configuring the SLD Bridge: 
 
 If you have already performed the initial configuration of SLD as part of the AS 

Java system installation, ignore the steps below. 
 You need to change these settings only if the RFC server configuration needs to 

be changed. 
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 To check the current settings on the SLD home page, 
choose  Administration   Details    Data Suppliers . 

 On the SLD home page, choose  Administration  Settings  and from 
the Section field choose data supplier . 

 Maintain the gateway host and a name of the gateway service. The SAP 
NetWeaver AS for Java standalone includes a gateway on the Central Services 
Instance, which is used if no gateway is configured explicitly. 

 

28. RFC Destinations 
 
When calling a function module using the RFC interface, the calling program must 
specify the parameters of the connection in the form of a destination. This 
destination defines the type of connection, the partner program, and the target 
system. You can manage it using transaction SM59, and it distinguishes between a 
variety of connections, such as TCP/IP or SAP connections. 
 

NWA -> Configuration -> Connectivity -> JCO RFC provider 
Create Program 
SM59 -> TCP/IP Connection and Click on Create button 
Provide Program name and Gateway host details.  

 

29. BCM 

 
Using the Broadcast Message editor, administrators can send messages to groups of 
portal users at run time. 
 
Broadcast messages can be sent immediately to the defined portal users, or you can 
specify that the message only be displayed to users during a given time frame. When 
the message is active, portal users receive notification in the portal masthead. 
 
Copy Sample_BroadcastMessageIview, Broadcast message Framework iview under 
Portal Content-->Portal Applications--> 
com.sap.portal.broadcast.message.framework to Portal Content -->> <Any Folder> 
and paste it as pcd object with the same name or choose different name. 
 
Open Ajax Framework Page and add Broadcast Message Framework and Broadcast 
Message iviews as delta link to the page. Make sure it is under Masthead Container 
and Visible. 
 
Enable Broadcast Messaging service: 
 Access SAP NetWeaver Administrator >> Configuration >> Infrastructure >> 

Application Modules >> search for <com.sap.portal.broadcast.message.service> 
 In Web Module Details click broadcast message service 
 In Portal Service Details change BCM is Active property to true 
 Assign the user broadcast messaging role 
  a. Access User Administration 



        SAP Enterprise Portal 

Prepared By 

Vamshi Krishna Katta 

23 

  b. Add broadcast_messages_role to the users or groups. 
 
Creating Broadcast Messaging 
 Login to portal-->Click on Broadcast messages-->New 
 Add Broadcast Message Name >> click Next >> You can choose the message 

Priority <High, Normal>  Write the Broadcast Message in the Message Box and 
set the time frame and click Next 

 Assign role or group to display the message for certain users or groups then click 
Next and then click Finish 

 Enter role or group to display the broadcast message. 
 Now you can check the message status from the Broadcast Message Overview 
 After the creation of broadcast message we need to restart the Broadcast 

message services 
 When the message is active it will show Next to the user name at the Masthead. 
 

30. Creating Mass Users 

 
 First of all create a master user based on which you can create multiple users. 
 When you are done with it export (by selecting the option at user creation) it. 
 We can see some text in a window copy it create a txt file with it, and add as 

many users as you want by copy pasting the text multiple times and making 
necessary change as per the names etc... 

 save the txt file. 
 Goto import option you were talking about and import the text file and update 

it. 
 As it gets updated you are done with the creation of multiples users. 

 

31. Permissions 

Permission levels for the administrator of portal content are as follows. 

Permission 

Level 

Description 

Owner Provides all permissions permitted by full control and also enables the 

authorized user/group/role to modify the permissions of the object. 

Full Control Provides all permissions permitted by read/write (next row), and also 

enables the authorized user/group/role to delete the object. The use of 

the Cut action in the Portal Catalog requires at least administrator full 

control permission to an object or folder being cut to the portal 

clipboard. 

Read/Write Provides all permissions permitted by read and write (next row), and 

also enables the authorized user/group/role to: Add to and remove 
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child objects from a parent object 

Edit the object properties 

The use of the Paste action in the Portal Catalog require at least 

administrator read/write permission to the destination folder in which 

an object or folder is being pasted. 

Write This permission setting is not select table from Permission Editor. It is 

relevant only to folders in the Portal Catalog and not to objects in the 

folder. 

The permission level is transparently applied by portal applications at 

the API level to folders that require it. 

A Folder with write permissions allow authorized users to create 

objects in it. 

This permission can be used to allow the end user to create and share 

content. To support this, the Everyone group could be 

granted write permission to a particular folder intended as a container 

for all users in the group to share any content they create in it. 

Read Enables the authorized user/group/role to: 

View the object in the Portal Catalog using the browse and search 

capabilities. 

Open the object in its respective primary and secondary editors in 

read-only mode; the object cannot be modified. 

To create instances (delta links and copies) from the object. 

To gain access to and choose templates in the object creation wizards. 

The use of the Copy action in the Portal Catalog requires at least 

administrator read permission to an object or folder being copied to 

the portal clipboard. 

This permission level can be used to prevent portal administrators from 

editing a particular object, while still allowing them create an instance 

of the source and use the new instance in any way. For example, if you 

create a delta link instance of an object with read permission and place 

it in a folder with read/write permissions, you may fully edit the delta 
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link object. 

None The user is not granted access to the object or folder in any 

administrator tool displaying the Portal Catalog. 

This setting is useful if you are providing content to a role that is purely 

runtime-based. If this is the case, you need to assign end-user 

permissions. 

 

32. Infotypes 

 
Steps to create a HR Infotype: 
1) Go to Transaction PM01. 
2) Enter the custom Infotype number which you want to create 
3) Select the 'Employee Infotype' radio button. 
4) Select the 'PS Structure Infotype'. 
5) Click on Create... A separate table maintenance window appears... 
6) Create a PS structure with all the fields you want on the Infotype 
7) Save and Activate the PS structure 
8) Go back to the initial screen of PM01. 
9) Click on 'All' push button. It takes a few moments. 
10) Click on 'Technical Characteristics'. Infotype list screen appears 
11) Click on 'Change'(pencil) button 
12) Select your Infotype and click on 'Detail' (magnifying glass) button 
13) Give 'T591A' as subtype table 
14) Give 'T591S' as subtype txt tab 
15) Give your subtype field as subtype field 
16) Save and come back to PM01 initial screen 
17) Click on 'Infotype Characteristics' ... Infotype list screen appears 
18) Click on 'Change' (pencil) button 
19) Click on 'New Entries' 
20) Enter your Infotype number and short text 
21) Here we have to set different Infotype Characteristics as per the requirement. 
(Better open another session with some standard Infotype's infotype characteristics 
screen and use as the reference to fill yours) 
22) Save your entries. 
23) Now the Infotype is created and ready to use. 
24) If you want to change the layout of the Infotype as per your requirement... 
25) In the PM01 initial screen...Select 'Screen' radio button and give 2000 as the 
screen name, then click on edit. 
26) In the next screen.. Select 'Layout Editor' and click 'Change'. 
27) Screen default layout appears...here you can design/modify the screen..change 
the attributes of the fields..etc. 
28) Save and activate. (Don't forget to 'Activate at every level) 
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Subtype Creation : 
 
 Transaction PM01 Goto Subtype Characteristics. Click on Append and then 

subtype. Enter the name and description of subtype on screen. 
 Then goto technical Characteristics and maintain the details of subtype there. I.e 

name of subtype i.e. component name defined in PSnnnn. Subtype table is 
T591A. 

 Subtype text tab is T591S and time const tab is T591A. 
 

33. Framework page customization 

 
We recommend that you base your framework page on the provided  
Ajax Framework Page. 
1. Go to -> Content Administration -> Portal Content Management 
2. In the Portal Catalog -> go to -> Portal Content -> Portal Users ->  
Standard Portal Users -> Ajax Framework Content. 
3. In the context menu of the Ajax Framework Page -> select -> Copy 
4. In the context menu of the folder in which you want to create your framework 
page, select -> Paste -> Create a Copy 
5. Recommendation: Change the name, ID, and prefix of the new framework page by 
selecting -> Change ID -> from the context menu 

 
https://www.sap.com/documents/2011/07/80a37656-5b7c-0010-82c7-eda71af511f
a.html# 

 

34. Integration with SRM 
 
1.Deploy SRM BPs in portal. 
To check BP deployment: Go to content administration > Portal Content > Business 
Object-->SRM 
 
2.Add SRM system in SLD. 
 
3.Create a new system in portal under System Administration -> System Landscape 
with SRM as backend. 
 
4.Configure SSO between portal and SRM. 
 
5.Assign required roles to user at the backend (SRM) and also in portal. 
 
6.Configure the Universal Worklist for the Business Package for SAP SRM 
A system connection for the SRM backend is already exist with alias SAP_SRM. 
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35. Integration with CRM 

 
1.Deploy SRM BPs in portal. 
To check BP deployment: Go to content administration > Portal Content > Business 
Object-->CRM 
 
2.Add SRM system in SLD. 
 
3.Create a new system in portal under System Administration -> System Landscape 
with CRM as backend. 
 
4.Configure SSO between portal and CRM. 
 
5.Assign required roles to user at the backend (CRM) and also in portal. 
 
6.Configure the Universal Worklist for the Business Package for SAP CRM 
A system connection for the CRM backend is already exist with alias SAP_CRM. 

 

36. Integration with BW 

 
1. Create System object  
 System alias should be SAP_BW.   
 Web AS Path --> usually /sap/bw/bex.   
 
2. Creating BW iview 
 Right Click on Portal Content, a Panel is displayed select New--> IView    
 Select IView template, click next   
 Select BEx Web Application IView from the list of templates available. Click 

next.   
 Give the IView name and IView ID. Incase you want to give any brief notes about 

the IView then give it in Description field. Click next.  
 Select the appropriate BW version. Click next.  
 Now to get the information "BEx Web Application Query String". open the SAP 

Log on and open the BW Browser, double click any of the queries available, this 
will open a window and select the Query String ( it should be between & to end 
&). Click Next   

 Now Preview the IView   
 We can see a new Window where in the selected BW report is seen.  

 

37. Integration with BI 

 
We can integrate Business Intelligence (BI) content from Business Objects into the 
SAP NetWeaver Portal. With this integration, customers are able to mix BI content 
and other applications easily. 
They can also personalize delivery of content based on SAP user roles and groups. 
Having enterprise-wide access to relevant business information from a standard 
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enterprise portal allows customers to make better-informed decisions. Consolidating 
the infrastructure for application and BI content delivery leads to reduced cost and 
time savings. 
We integrated Portal 7.3 SP 7 with BOBJ Version: 4.0 SP 4 Patch 3 using below steps. 
The steps are more or less similar for other portal versions. Use references section 
for other versions of portal & BOBJ. 
 
Steps: 
 
 1. Get 
the com.sap.businessobjects.iviews.par and com.sap.businessobjects.iviews.templat
es.epa files from below BOBJ BI server location: 
       [BI4_INSTALL_PATH]/SAP BusinessObjects Enterprise XI 
 4.0/warfiles/portlet/iviews 
  2. Import EPA file to Portal as shown below. Wait till import gets completed 
successfully (avg. 1 minute) and then restart portal. 
3. Prepare EAR file from EPA file. 
  Follow instructions in SAP Note “1672422 – It’s not possible to create an iView 
using the Business Objects Document List Template iview and the    Enterprise 
Portal 7.3” to correct com.sap.businessobjects.iviews.par file and then migrate to 
EAR file. 
4.    Deploy the EAR file to portal using NWDS. 
5. Create System Object using new system template: SAP BusinessObjects System 
Template 
Maintain the properties – Group, Logical System name, Message Server, SAP Client, 
SAP System ID, Server Port, and System Type 
Connector system is nothing but SAP system (most cases BW) used for SAP 
authentication of BOBJ. Contact your basis team for these details. 
6. Make sure SSO is configured between Portal and SAP System mentioned in 
connector properties of System Object in last step. 
Connection test shall work fine for SAP_BOBJ system which we created in earlier 
step. 
7. Create iView using SAP_BusinessObjects_Document_List template for BI launch 
pad. 
Update the Business Objects properties of iView 
Preview iView and you will directly get logged into BI launch pad. We are done! 
 
https://blogs.sap.com/2013/04/04/integration-of-bobj-with-sap-portal/ 

 

38. Integration with UI5 
 
Prerequisites: 

a. Make sure you install the SAPUI5 Application Development feature as well as 
the SAPUI5 ABAP Repository Team Provider feature in you Eclipse 
installation. 
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b. Make sure that the software component SAP UI5 TEAM PROVIDER ON 731 
(UI5_731) is installed on the 7.31 ABAP backend 

c. 7.31 ABAP backend. 

Sharing the SAPUI5 Application Project with the SAP Gateway(ABAP) Server: 

Create a SAPUI5 project in Eclipse and test locally 

 

Sharing the project : 

Right click on the Application created,Team and select share project. 

 

https://blogs.sap.com/wp-content/uploads/2014/01/image2_357050.gif
https://blogs.sap.com/wp-content/uploads/2014/01/img3_357051.png
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Select SAPUI5 ABAP Repository and click on next 

 

 

 

Provide the ABAP system details to which you are going to upload the data and click 
on Next. 

https://blogs.sap.com/wp-content/uploads/2014/01/img4_357052.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture1_357068.png
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The SAPUI5 application project can either be shared with an existing or with a newly 
created BSP application. 

 

 
Select Create a New BSP Application and enter name, description, and package 

 

https://blogs.sap.com/wp-content/uploads/2014/01/picture2_357069.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture3_357090.png
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Create a new transport request or select an existing request and then click on finish. 

 

Submitting the SAPUI5 Application Project to the ABAP Repository 

Right click on the project which has been shared in Eclipse,Go to Team and select 
Submit. 

https://blogs.sap.com/wp-content/uploads/2014/01/picture4_357091.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture5_357113.png
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Select all files and click on Finish. 

This will created as an BSP Application in ABAP System. 

Now logon to the ABAP system to see our application. 

Go to the transaction SCIF 

 

Enter the created Application name in Service name field and execute. 

You would see the submitted application as shown 

https://blogs.sap.com/wp-content/uploads/2014/01/picture6_357114.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture7_357115.png
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Integrating SAPUI5 Application in Portal: 

1. Navigate to the Portal System administration and create a system object 
pointing to the target ABAP system 

2. Create an SAPUI5 iview with properties(System,UI5 Relative Path,HTTP 
Request Method) in Content Admin 

      Go to Content Administration Portal Content Management  Portal 
Applications.com.sap.portal.appintegrator.sap UI5 

      Copy the UI5 application iView and paste it in your own folder. 

 

Open the Iview and Provide the following properties. 

HTTP Request Method: HTTP GET 

https://blogs.sap.com/wp-content/uploads/2014/01/picture8_357122.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture9_357124.png
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System             :(System alias) 

 

UI5 Relative Path:Path to the backend application. 

 

Finally Add this iview to a role. 

 

 

 

39. Integration with Fiori 

 
 Create a system object and give it an alias, such as ‘WEBSIDP’. This system will 

actually points to on the same URL we are using to access the portal – the web 
dispatcher. 

 Enter the following mandatory settings for this system object: 
 SAP Client: 123 
 ICM Protocol: http 
 Web AS Host Name: dispatcher.sap.com 
 Set the system HTTP Security Session to be on. You can set other properties too 

according to your needs. 
 Create a Fiori iView. 

https://blogs.sap.com/wp-content/uploads/2014/01/picture10_357126.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture11_357127.png
https://blogs.sap.com/wp-content/uploads/2014/01/picture12_357128.png
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 In Content Administration, create a new iView from template and select SAP 
Fiori iView. 

 Go through the wizard, choose a name for your iView, and then click Next. 
 In the next screen, fill in the details as follows (according to the example): 
 System: WEBSIDP (this is the system alias we defined before) 
 Relative Path for SAP Fiori Application: 

sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html 
 Parameters to Pass on the Location String in the URL: 

Shell-runStandaloneApp?sap-ushell-SAPUI5.Component=cus.crm.opportunity&s
ap-ushell-url=/sap/bc/ui5_ui5/sap/crm_opprtnty 

 If you leave this field blank you will simply get the SAP Fiori Launchpad (FLP). 
 SAP Fiori Application Header: You can choose one of the following: 
 No Header – you will not see the FLP header, personalization will be off 

(disclaimer: supported as of ABAP Add-on SP10) 
 Minimal Header – You will have the FLP header with functions that match 

embedded mode, personalization will be enabled (supported as of ABAP add-on 
SP9) 

 Click Next, then Finish. 
 Once this is done you can preview the iView. All the properties that you entered 

with the wizard are still available via the iView property editor under the 
category ‘Content – Fiori’ 

 Unless you have a custom theme maintained in the portal that is suitable for an 
SAPUI5 application, set the Hand Over Portal Style Sheet property on the iView 
to false. The Fiori application will be rendered with the default theme of the 
application, as it is on the back-end system. 

 

40. Fiori Launch pad on Portal 

 
SAP Fiori Launchpad on Portal is available only for newer Product Version(s) 
Release(s) 

 Netweaver (NW) 7.31 Support Package (SP) 12+ 
 Netweaver (NW) 7.4 Support Package (SP) 7+ 

 
Configuration Setup: 

1.Overview 

The first point of configuration in terms of setting the SAP Fiori Launchpad on 
Portal up is to enable the property settings accordingly and this will be performed by 
a validated System Administrator who holds valid authorizations. 

 To permit the enable of the Launchpad a new URL alias needs to be created 
and maintained. 

 This “URL Alias” is used in association to the Fiori Desktop and “Master Rule 
Collection“. 
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 Through creating the new URL Alias for the “Fiori Desktop” you then need to 
set the conditions via the “Master Rule Collection“. 

 For comprehensive guidance on the URL Setup and Master Rule 
Collection the following help documentation can be cross-referenced: 

 Defining URL 
Alias:https://help.sap.com/saphelp_nw74/helpdata/en/48/1d5d0171364269
e10000000a421937/content.htm 

 Defining Portal Display 
Rules:https://help.sap.com/saphelp_nw74/helpdata/en/48/1f04f680093184
e10000000a42189b/content.htm 

2.iViews 

Now after the URL Alias has been defined and the Master Rule Collection has been 
reviewed and checked in accordance to business standards and requirements the 
next steps are regarding the iView and Page Setup. 

The SAP Fiori Launchpad adds a fresh dimension to iView display as such a 
presentation is returned to the End-User in the form of Fiori Tiles as opposed to the 
familiar Portal iView standard. 

In this phase we define which iViews & Pagesare going to be defined and returned to 
End-Users in the form of Tiles & Catalogs. There are two types of tiles which can be 
defined in association to iView displays with each offering their own sense of 
suitability for business preference: 

 Static Tiles: consistent and standard information which maintains a defined 
display. 

 Dynamic Tiles: as the name suggest the setup here is based on regularly 
changing information through oData. 

In order to determine the Tiles (iViews) and define the setup: 

1. Login to the Enterprise Portal 
2. http://<host>:<port>/portal 
3. Navigate to “Content Administration” & then “Portal Content Management”. 
4. Locate the “Portal Catalog“ 
5. Select the iView of interest (from Portal standpoint)  and open the context 

menu. 
6. Open the iView properties through “Open“, “Properties” and make the 

change for FLP (Fiori Launchpad) display. 
7. Once the change is made you need to select “Modify Properties” 

and Save your changes. 

3.Catalogs & Categories 

https://help.sap.com/saphelp_nw74/helpdata/en/48/1d5d0171364269e10000000a421937/content.htm
https://help.sap.com/saphelp_nw74/helpdata/en/48/1d5d0171364269e10000000a421937/content.htm
https://help.sap.com/saphelp_nw74/helpdata/en/48/1f04f680093184e10000000a42189b/content.htm
https://help.sap.com/saphelp_nw74/helpdata/en/48/1f04f680093184e10000000a42189b/content.htm
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In high level terms we can refer to “Catalogs” & “Categories” as the means of 
grouping applications. Let us revert back for a second and re-reference the types of 
applications we can use in association to SAP Fiori. 

 Analytical Applications 
 Transaction Applications 
 Fact-sheet Applications 

The three application types are diverse and can be tailored dependent on your own 
business requirements within an organizational establishment. 

 20 Categories can be holstered within the Properties Editor (2 of which are 
default standard). 

There are two application listing types here: 

 General: unassigned applications which are not explicitly defined in 
correlation to a category. 

 Recommended: suggested and advocated applications which appear as 
potential tags. 

From personal experience there is a very important point to highlight here. 

 A category will not be displayed if there is no applications defined in its 
association. 

To set Catalogs & Categories: 

1. Login to the Enterprise Portal 
2. http://<host>:<port>/portal 
3. Navigate to “Content Administration“, “Portal Content Management“. 
4. Locate the “Portal Catalog“ 
5. Navigate through “Portal Content“, “Portal Users“, “Standard Portal Users“, 

“iViews“, “Fiori Launchpad“, “Fiori Launchpad Categories“. 
6. Select & Open the “Fiori Launchpad Category“. 

Within the editor you need to ensure that each of the following are defined: 

 Category ID which is the unique identifier. 
 Category Order which determines the precedence and order of categories 

within the tile catalog. 
 Category Title i.e. the name of the catalog. 

Now you need to assign an iView to the category which has just been defined in 
order to get it to display and return it to end-users. 

1. Open the iView properties through “Open“, “Properties“. 
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2. Select “Personalized Launcher” within “Category Assignment” and fill in 
the identifier ID’s 

3. Any category definition should be separated through the use of a semi-colon. 

4.Navigation & the FLP 

In this section we are going to determine the way in which the FLP returns its 
element in window display to our end users. From a high level perspective we need 
to consider this in terms of work feasibility and requirement suitability. 

Some of the options available here include: 

 FLP within the Portal Content Area (central window element of the Enterprise 
Portal) where standard applications are rendered. 

 Display within a separate Window (newly opened tabular window) 
 Separate headerless Window (conjoined to the Portal Session, but opened 

within a headerless framework window) quirks mode (older) 
 Separate headerless Window (conjoined to the Portal Session, but opened 

within a headerless framework window) standards mode (newer) 

Setting the Navigation Type 

1. Login to the Enterprise Portal 
2. http://<host>:<port>/portal 
3. Navigate to “Content Administration” & then “Portal Content Management“. 
4. Locate the “Portal Catalog“ 
5. Select the iView of interest 
6. Open the “Properties Editor” and select “Show Category” and click 

“Navigation“ 
7. Determine and define the navigation means of preference as described 

above and save your changes. 

5.Resetting User Displays Personalization 

If you wish to reset the display settings for users i.e. personalized settings this can be 
done through property editing or removing the personalization property data for 
com.sap.portal.navigation.flp.pl.UserData. 

 

41. NWBC 

 
 NWBC for HTML is a browser based version using HTTP/s for connecting to a SAP 

NetWeaver Application Server ABAP backend. SAP GUI transactions are 
rendered using the SAP GUI for HTML. 

 Download NWBC for Desktop client installation from SAP(service Market place) 
 Install the NWBC for Desktop 4.0 
 Activate the NWBC on ABAP system in T-code SICF “/default_host/sap/bc/nwbc 
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 You will get the URL link 
like https://<servername>:portno/sap/bc/nwbc?sap-client=000 

 Click the NWBC and mention the URL 
 Then click on log on 
 Once you activated the services , the URL will generated and able to access SAP 

from HTML page. 

 

42. Transport 
 
 System Administration -> Transport ->Export -> Create Transport Packages -> 

Add content -> Click on Export button ->Download .epa File 
 System Administration -> Transport -> Import -> Source for package files : Client 

-> Browse .epa file -> Click on Upload -> Import the file. 

 

43. Translation 

 
 The SAP NetWeaver Portal provides a process for translating the text of portal 

objects such as iViews, pages, work sets, roles, and systems. Multilingual object 
metadata for portal objects is stored in the database of the Portal Content 
Directory (PCD). If a property of a portal object has the type text attribute , it is 
marked as text and can be translated (for example, the name and description 
properties). 

Steps: 
 Create worklist and add content 
 Generate Translation data 
 Release for translation 
 Search worklist and define source and target languages 
 Load worklist for translation  
 Translate worklist 
 Mark worklist as translated 
 Publish Translation 

 

44. Remove irj/portal 
NWA-> Configuration-> Connectivity -> HTTP provider configuration 
Start page = irj/portal 
 
 
IRJ: 
The SAP NetWeaver Portal is a J2EE application that is designed to handle HTTP 
requests for portal components. A portal component is a Java class written and 
packaged specifically to run in the portal. The portal application is deployed under 
the URL /irj. Therefore, IRJ is the SAP Enterprise Portal running under SAP 
NetWeaver Java Application Server. 
 

45. External Facing Portal  

 

https://gbwut043.got.volvocars.net:444/sap/bc/nwbc?sap-client=000
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https://wiki.scn.sap.com/wiki/display/EP/External+Facing+Portal 

 

Web Dynpro Java:  
 

46. Component 
 
 Web Dynpro Component : Component is a reusable object mainly for business 

process. A component is a set of views, controllers, models, and windows. 
Component is a central unit of Development Component. Component acts as a 
global data unit where it can be used by all the controllers and views.   

 
 Development Component : A Development Component contains several web 

dynpro components. We can have any number of Development Components. 
 
 Software Component : A Software Component contains several Development 

Components. We can have any number of Software Components depending 
upon our requirement. Several Software Components makes a Software. 

 

47. DC’s 

 
Development Component : A Development Component contains several web 
dynpro components. We can have any number of Development Components. 

 

48. Controllers 
 
Controllers are the active parts of web dynpro components which holds the data in 
the context. Controllers are of 5 types : 
 Component Controller 
 View Controller 
 Window Controller 
 Custom Controller 
 Interface Controller 
 
 
 
 
 

49. Supply functions 

 
 It is used to populate the entire node collection. A single ton node should contain 
supply function. Supply Functions are called automatically at run time. 
Supply Function can be called in the following scenarios : 
 It has never been populated before. 
 The lead selection in the parent node is changed or deleted. 
 If we are explicitly calling invalidate method. 
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50. Dispose functions 
 
Before calling Supply Functions to populate the node the node collection should be 
saved. This is done by using Dispose Functions. 

 

51. Cardinality 

 
Cardinality is a property which is used to control the elements in a Node. It defines 
node collection at run time which specifies max and min number of elements. 
Cardinality is of two types : 
Collection Cardinality : It specifies how many number of elements can    
     be stored in a node.  
Selection Cardinality : It specifies how many number of elements can    
     be selected from a node. 
Cardinality values are of 4 types: 
1) 0 to 1 : The value can be 0 or 1. 
2) 0 to n : The value can be 0 or more. 
3) 1 to 1 : The value is only 1. 
4) 1 to n : The value can be 1 or more. 
If Cardinality value begins with 1, it means that after context is initialized there will 
be at least one element acts as the default element. 

 

52. Simple Types 
 
Simple Types : These are the parts of dictionaries which include SVS,EVS and OVS. 
Simple Value Selector (SVS) : SVS is used for specifying the key UI   
 elements for drop down list. It can hold up to 50 elements. 
Extended Value Selector (EVS) : EVS is an extension of SVS which   can hold 
more than 50 elements. 
Object Value Selector (OVS) : SVS and EVS are used to store the    values 
where OVS is used to store the objects. 

 

53. Models 

 
It is an object which contains the data and functions of ECC system.  
Types of Models : Models are of 4 types : 
 Adaptive RFC2 :  
 Adaptive web service : 
 Enterprise Java Bean : 
 Java bean :  

 

54. Context binding, Model binding 
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Context is a hierarchical representation of data storage. Data present in the context 
of component controller will have the life span of controller. Data is stored in the 
form of Nodes and Attributes where Nodes contains Attributes and Attributes 
contains values. 
 
Model Binding : It is process of binding the model object attributes to controller 
context attributes. 
 
Context Binding : It is the process of binding between UI elements and attributes of 
context controller. 
 
Mapping : It is the process of binding one controller context elements to another 
controller context elements. 

 

55. RFC 

 
It is a function call which is used to connect from one SAP system to another SAP 
system. 

 

56. BAPI 
 
BAPI is also a function call which is used to connect from SAP to SAP as well as SAP to 
SAP to NON SAP systems. Every RFC is not a BAPI but every BAPI is an RFC. Every RFC 
can be converted into BAPI by placing the RFC into Business Object Repository (BOR) 
and then by releasing it. 

 

57. Messaging 
 
Message Pool : It is used to display messages and alert information. Messages are of 
5 types : 
1)Text    2) Success   3) Warning  4) Error  5) Fatal 
Dictionaries : Dictionary acts as a repository for the data types and structures.  

 

58. Creating a DC with Model 

 
 Create a model that is used to connect to the SAP backend from the Web 

Dynpro project  
 Implement access to remote function modules in an SAP system  
 Implement custom controllers for specific tasks that cannot be assigned to a 

single view  
 Create contexts for the custom controller and bind them to the model  
 Create view contexts and map them to the custom controller context  
 Bind UI controls to view context elements  

 

59. Web Dynpro JAVA vs Web dynpro ABAP 
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Webdynpro for ABAP and Webdynpro JAVA use the same declarative meta 

model concept based on MVC pattern to create web applications. Everything about 
Webdynpro ABAP is same as Webdynpro JAVA, except that it uses ABAP as 
programming language instead of JAVA. It also has a graphical interface tool that is 
integrated with the ABAP Workbench (Transaction Se80). Both Webdynpro ABAP 
and Webdynpro JAVA applications are run in the Enterprise Portal. 
 
Developing with Web Dynpro ABAP offers the following advantages for application 
developers: 
 
 Declarative and graphical tools minimize the implementation effort 
 Support of a structured design process 
 Strict separation between layout and business data 
 Reuse and better maintainability through use of components 
 Layout and navigation are easily changed using Web Dynpro tools 
 Support of stateful applications because when paging is used, the data required 

again is kept, which means the whole application can be accessed at any time. 
 Data binding enables automatic data transport 
 Automatic input checks 
 Support of accessible user interfaces 
 Full integration into established ABAP development environment 
 
  Web Dynpro JAVA:- 
 
     Web Dynpro JAVA is available from the year 2004 with Net Weaver 2004 and 
Web Application Server (WAS) 6.40, and is used to create applications such as the 
Employee Self Service (ESS) and Manager Self Service (MSS).SAP has reduced the 
promotion of Web Dynpro Java; however, they are going to support it till 2018. This 
makes it clear that Web Dynpro ABAP will be the preferred UI Technology. 
 
  Web Dynpro ABAP:- 
 
    Web Dynpro ABAP is available from Oct-2005 with Net Weaver 7.0 and Web 
Application Server (WAS) 7.0, from the day of its availability it is widely used and 
preferred UI Technology. 

  

 

60. NWDI  

 
It provides an infrastructure for developing applications centrally where multiple 
developers can work on the components of the application. Used for custom 
development and webdynpro development.  
Prerequisites for nwdi 
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Usage type AS java must be installed for nwdi 
Installation of DI( CMS, DTR AND CBS) 

 
 A software Component (SC) defines a deliverable, deployable unit. It consists of 

a number of development components (DC). A SC is basically only a logical shell 
around a number of DCs. 

 
 Development components (DCs) are the reusable building blocks for software 

components. A DC is a named container for arbitrary objects, e.g. Java source 
files, JSPs, dictionary definitions, deployment descripters, etc.  

 
 The Design Time Repository (DTR) is a source code management (SCM) or 

version control system (VCS) like Perforce, ClearCase, CVS and others. The DTR 
operates on files or folders. All files that make up development components are 
stored and versioned in a DTR.  

 
 The Component Build Service (CBS) is a central service that builds your 

development components. When you activate an activity - automatically after 
check-in or manually from the Activation View - the CBS builds the 
modified DCs and all DCs that depend on them. 

 
 The Change Management Service (CMS) is a central service which is responsible 

for definition and administration of a development landscape consisting of one 
or several CBS and DTR servers and a Name Server. Development Configurations 
are created by a CMS administrator.  

 
Steps: 
 
 http://<host name>:<port number>/devinf 
 
1.Creating and assigning required Roles and Actions in portal UME 
 Create two groups for NWDI users in Portal UME. 

NWDI.Administrators 
NWDI.Developers 

 Create NWDI_Admin and NWDI_Developer users and add these users to 
 corresponding 
groups NWDI.Administrators and NWDI.Developers simultaneously. 

 Search for NWDI.Administrator Role else Create and Assign it 
 to NWDI.Administrators Group. Similarly search for NWDI.Developer Role 
else  create and assign it to NWDI.Developers Group. 

 Open NWDI.Administrator Role and assign following Actions 
CBS.Administrator 
CMS.Administrate 

 Open NWDI.Developer Role and assign following Actions 
CBS.Developer 
CMS.Display 
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CMS.Export 
 

2.Assigning SLD Roles to Groups  
For respective groups assign corresponding security roles. 
NWDI.Administrators               LcrInstanceWriterAll 
NWDI.Developers                    LcrInstanceWriterNR 

 To assign above said security roles to NWDI groups, Go to Visual Administrator 
to set up user privileges for J2EE Engine. Visual Administrator can be opened via 
following path <SAP-install-dir>\<SID>\JC<instance no.>\j2ee\admin\go.bat 

 Login as Administrator 
 Open the navigation tree on left side of screen and 

go Server -> Services -> Security Provider 
 In the right-hand window, choose the tab Runtime -> Policy 

Configuration -> Security Roles. 
 In the Components section, choose the application sap.com/com.sap.lcr*sld. 
 Under Security Roles, select the security role LcrInstanceWriterAll. 
 Under Mappings you find the Groups field. Choose Add. The dialog window 

Choose Users or Groups appears. 
 Select the Groups tab page. 
 Choose Search. A list of the availableUMEgroups appears. 
 Choose the NWDI.Administrators group and then OK. 
 Your data is being saved. 
 Now assign the LcrInstanceWriterNR security role to the JDI.Developers group. 
 
3.Prepare System Landscape Directory (SLD) 
 Reach initial page of SLD under URL http://<server>:<port>/sld 
 Go to Products link under Software Catalog section. 
 To define New Product Version click on button available for same. Fill 

parameters and click create. 
 Product “Training, abc.com, 1.0” is created and define SAP Software Unit for 

same as shown below. Click Create button. 
 Add Software Component to created Product “Training..”. 
 Define SC Name, Version and setProductionStateparameter to Started from 

Drop Down list. Click on create to complete this step. 
 New Product and corresponding Software Component is created in SLD. 
 
4.Defining Software Component Dependencies 
 Go to Software Component to see created SC. 
 For this select Software Component value from drop down list of Software Type 

as mentioned in screen below. 
 Search for your SC in available components list. In our case it is “Demo”. 
 In SC, go to Dependencies Tab 
 Now, we need to define Build Time dependency on components 

like SAP-JEE, SAP_BUILDT, SAP_JTECHS. 
 To perform this select Build Time value from drop down and click Define 

Prerequisite Software Component Version button. 
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 Following pop up screen appears displaying all available Software Components 
available. 

 Search for SAP-JEE component to define Build Time dependency for our SC. 
 Click on Define Prerequisite Software Components to add selected component. 
 Multiple selections are possible. 
 Similarly, Repeat above-mentioned step 

for SAP_BUILDT and SAP_JTECHS components and add one by one. 
 All added components would be enlisted in table under dependency tab. 
 By completion of this step, SLD configuration for NWDI use is over. 
 
5.Configuration of Change management System or CMS  
 In the browser, start the initial page of the SAP NetWeaver Java Netweaver 

Development Infrastructure with the following URL http://<host&gt;:<port 
number>/devinf  

 Login using NWDI_Admin user. Following Home Page appears. 
 Click Change Management Service. System may prompt to re-enter user and 

password. Login using NWDI_Admin user. Following screen appears 
 
6.Create a Domain and Track in CMS  
 Go to Landscape Configurator to Define Domain and Track for CMS 

Configuration. 
 Go to Domain Data tab to define a Domain in landscape for SC development. 
 Fill up required parameters with essential and correct information and click Save 

button to create a Domain. 
 Note: In transport directory, keep the default path as /usr/sap/Jtrans 
 Go to Track Data tab and create New Track. 
 Define Track Id, Track Name and Track Description for New Track 
 Define Development Configuration Path usually <TrackId>/1.0 
 In Software Component section, Add SC in Developed Software Component 

Table.  
 New window pop up appears. Look for Software Component, which you have 

defined in SLD. 
 Select SC and click Add. Click Close to close window. 
 Software Component is added to Developed Software Components under 

Software Component Section. 
 Click on Save to Finish Track Creation. 
 Select Track on left side table and Go to Runtime Systems Tab on same Track 

Data Page. 
 Click on change button. 
 Check Development option. 
 There appears Runtime System Configuration Wizard. 
 Fill up required parameters and click next button. 
 In next screen fill required parameters and finish. 
 Runtime System for Development is configured. 
 With this “Training” Track is configured. 
 On completion of Track creation, DTR and CBS are also configured. 
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7.Verify CBS and DTR Configuration 
 To check DTR contents use following link http://<host>:<port>/dtr 
 Or use Design Time Repository link available on CMS home page. 
 “Training” Track is available in DTR for use. 
 To check DTR contents use Component Build Service link available on CMS home 

page. 
 
8.Import Software Components into this track 
 The Software Component archives ( .sca files ) must be downloaded from the 

Service Marketplace ( http://service.sap.com/patches ) and placed into 
the inbox folder of the CMS.  The inbox folder can be found under the following 
path: <CMS Transport Directory>\CMS\inbox, where the <CMS Transport 
Directory> is specified in the “Domain Data” tab of the CMS Landscape 
Configurator). 

 In our case, this path is /usr/sap/JTrans/CMS/inbox                 Or 
 The .sca archive files can be picked from j2ee server from following 

location /usr/sap/NWD/SYS/global/CMS_CBS/plugins  Or /usr/sap/NWD/DVEBM
GS00/SDM/root/origin_sc/sap.com 

  The following .sca files must be placed into the CMS inbox folder: 
 SAP_JTECHS.sca 
 SAP_BUILDT.sca 
 SAP-JEE.sca 
 Note: The names of .sca files could be different. They may include version 

numbers, vendor name etc. 
 
9.Check-In archives 
 Now we will resume CMS configuration and again go to CMS home page. 
 Open Transport Studio. 
 Select your defined track. 
 Go to Check in tab. 
 Select all available .sca archive components in table and click Check-In button. 
 On successful completion, you will get system acknowledgment. 
 
10.Import the checked in archives into the Development system 
 Now go to Development tab, you will see all Checked-In archive components 

with following parameters for all: 
 State Import Check:                Not Executed 
 State:                                   Waiting for Import 
 Select a components and click on Import-Check button. 
 You will get confirmation dialog to proceed further. 
 After successful completion you will get State Import Check parameter as Check 

Finished. 
 Perform above step one by one for other available components also. 
 Select all components and click Import Button after completion of above steps. 
 It may take some time. 

http://service.sap.com/patches
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 On successful Completion State parameter of components is changed to Import 
Finished. 

 
11.Import the checked in archives into the Consolidation system 
 Now go to Consolidation tab of Transport Studio and import checked in archives 

as done in development tab. 
 Repeat all steps mentioned above to complete this step. 
 By performing above steps, CMS is configured. 
 
12.Configuring Design Time Repository (DTR) in SAP NWDS 
 Open SAP Netweaver Developer Studio on your client machine. 
 Go to Windows -> Preferences -> Java Development 

Infrastructure -> Development Configuration 
 Enter J2EE server URL http://<host>:<port> and Ping Server. 
 On successful connection, system will acknowledge with following message. 
 Go to Windows -> Preferences -> Team -> Ignored Resources 
  Make sure that “.classpath” & “.project” resources are checked. This is to avoid 

their entry to DTR. See below fig for reference. 
 Go to Windows -> Open Perspective -> Others -> Design Time Repository  
 Repeat same step to open Development Configurations Perspective. 
 Now Go to Design Time Repository Perspective by clicking on “dtr” icon as 

shown above in second fig. 
 Right click on offline and click on Create Client.  
 Fill all parameters in prompt screen. Click Ok. 
 After client creation, Right click on Offline and Login to DTR system. 
 Note: Use CMS_Developer User for login to DTR. 
 You can see created track in your DTR perspective.  
 Note: If your created track is not available in DTR, It will be available after 

following below steps 
 Switch Development Configurations Perspective. 
 Go to Local DC Section, shown in the middle of screen. 
 Right click to Import Configuration.  
 Following screen appears shown below. 
 Select remote option to get all configurations from DTR. 
 All available tracks in DTR get displayed. 
 Select your tracks. Open it to level of <Track Name>_dev. 
 Select <Track Name>_dev and click next. 
 Click Finish button to complete remote configuration import. 
 On completion of this step, your imported track “DEMO” is available in DC 

perspective. 
 Left most area of above screen shows inactive DC’s. Here you can right click on 

DEMO track to create your new DC. 
 Active DC tab shows all available active DC’s in DTR. This tab also shows 

defined Software Component Dependencies available under track. 
By performing above steps your NWDS is configured with DTR and is ready for use. 
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13.Import of Development Configurations 
 Click on remote. 
 Provide the credentials username and password select ok. 
 Select the track. 
 Click on Next and Finish button. 
 Right click on the application and select sync DC and after that create DC 
 
14.Go to Web Dynpro Explorer 
 Build the particular track 
 Once  it is build  deploy and run the application 
 Perform the steps for all the applications to build and deploy,run. 
 Here we completed the testing of the tracks in development system. 
 
15.Testing in quality and production systems. 
 Before we test the tracks in the quality and production systems we need to 

configure the portal details in the landscape configurator for the track. 
 Test Runtime System  - Quality System 
 Production runtime System - Production System 
 Then go to  Transport Studio click on assembly tab  
 Select Assembly Components 
 Select the track. 
 Then move to Test 
 Click on the Import and import all the SCA’s files related to track. 
 Perform the procedure to test all the tracks in quality system. 
 To perform the in production system click on the Approval tab and select all 

SCA’s files and click on Approve tab 
 Then the state will be changed to Approved. 
 Test the application again the production environment. 
 
FAQ: 
https://wiki.scn.sap.com/wiki/display/Java/NWDI+FAQ 

 

61. Upgrade Issues 

 
https://blogs.sap.com/2016/11/28/sap-enterprise-portal-upgradation/ 

 

 

 

 

 

62. Project Implementation steps 

 
 SSO Configuration 
 Create a System Object (Integrating with ECC System) 
 Creating Users and Groups 
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 Create PCD Objects 
 SLD Configuration 
 Create JCO Destinations 
 UME Configuration 
 UWL Configuration 
 Deploy ESS/MSS Business Packages 
 Launchpad customization for ESS/MSS 
 Assigning Permissions 
 Logon page customization 
 

63. FAQ’s 

 
http://onlysaep.blogspot.in/p/blog-page.html 
 
https://blogs.sap.com/2012/11/13/portal-interview-questions/ 
 
https://www.wisdomjobs.com/e-university/sap-enterprise-portal-interview-quest
ions.html 

 

http://onlysapep.blogspot.in/p/blog-page.html
https://blogs.sap.com/2012/11/13/portal-interview-questions/
https://www.wisdomjobs.com/e-university/sap-enterprise-portal-interview-questions.html
https://www.wisdomjobs.com/e-university/sap-enterprise-portal-interview-questions.html

